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TO THE TEACHER

Glencoe s I nteractive Chalkboard is an exciting multimedia teecher tool that enables you
to present dynamic lessons for every chapter of your mathematics text. Many of the
teacher resources you have come to rely on—including trangparencies and in-class
examples from your Teacher’s Edition—are now a your fingertipsin this easy-to-use
product. With I nteractive Chalkboard and a Web browser you aso get instant access to
extra examples a the Glencoe Web ste.

The I nteractive Chalkboard system is based on Microsoft PowerPoint, but you do not
need the PowerPoint software to use this tool since the PowerPoint Viewer isincluded on
the CD-ROM. If you do have access to PowerPoint 97 or later, you can easily customize
your presentations.

FEATURESOF INTERACTIVE CHALKBOARD
Each dide show includes the following features:

Step- by-step, dynamic solutions to each In-Class Example from the Teacher
Wraparound Edition

Additiona Your Turn exercises for each example

The 5-Minute Check Transparencies

Hot links to Glencoe Online Study Tools
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INSTALLATION INSTRUCTIONS
I nter active Chalkboar d

1. Insatthediscinto the CD-ROM drive. If you have autorun turned on, the ingtaler
will run automatically. In this case, skip to sep 4.
2. If autorun isturned off and the ingdler did not run autométicdly, click on the Start
button and choose the Run option.
3.  Typed:\setup\setup and press Enter. (Remember to use the gppropriate drive letter
that corresponds with your CD-ROM drive.)
4.  Follow the directions on the screen to complete the process.
5.  After completing the ingtdlation, check to make sure that your monitor is set to
hghcol or mode (thousands of colors) at 800 x 600 or higher resolution.
With your mouse, right click on the Desktop
Choose the Properties option.
Click on the Settings tab in the Display Properties didog box.
Check the Color palette and Desktop area settings.
Change the sttingsiif required.
Apply the new settingsif you made any changes.

Power Point Viewer

If you do not have PowerPoint 97 (or alater version) ingaled on your compuiter, ingtall
the PowerPoint Viewer software provided on the I nteractive Chalkboard CD-ROM.

1.  Click the Start menu button and choose the Run option.

2.  Type“d:\Medialngtallers\PPView97” (include the quotes) and press Enter.
(Remember to use the appropriate drive letter that corresponds with your CD-ROM
drive)

3.  Fallow theingructions on the screen to complete the ingtallation process. NOTE:
You must install the PowerPoint Viewer onto your local hard drive and not a
networked drive.
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RUNNING INTERACTIVE CHALKBOARD
Setting Up Your Equipment

Before you begin using the I nteractive Chalkboard system, check your equipment
connections. To use I nteractive Chalkboard, you will need a computer (see System
Reguirements on page 5) and a projector or large screen monitor capable of displaying
high-color (800 x 600 or higher) images.

Power Point 97 (or a later version) Start-Up Ingtructions

If you have PowerPoint 97 (or alater verson) you can useit instead of the Viewer to
display the presentations. (NOTE: If you are using Power Point 97, verify that your
version of PowerPoint 97 is at |east the SR-1 release by choosing About Microsoft
PowerPoint in the Help menu of the program after it opens. If your copy is not SR-1, or
later, download and install the free update from www.microsoft.com.)

Start the PowerPoint software. Follow the instructions that came with the program.
Choose to open a presentation.

Select your CD-ROM drive.

Choose a presentation (e.g., PAL1 Chapter 01).

Click the View menu and select the Slide Show option to begin the presentation.
When you gstart a presentation, you will see an opening dide. Click the Forward
button to proceed to the Contents dide.

From the Contents dide click the appropriate hyperlink to view the lesson dides.
Click the Help button for detailed ingtructions.

8. Toendthe presentation, click the Exit button or press the Esc (escape) key.
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RUNNING INTERACTIVE CHALKBOARD (continued)

Power Point Viewer 97 Start-Up Instructions

If you do not have PowerPoint 97 (or alater verson) instaled on your computer, follow
the indructions to run the Viewer program. If you have not ingtalled the Viewer, refer to
the ingtalation ingtructions on page 3.

1

SN

~

Make sure that your monitor is set to high-color mode (thousands of colors) a
640 x 480 or higher resolution. If your screen is not set properly, right click on the
Desktop, choose Properties, and change the monitor settings.

Click the Start menu button and choose the Programs option.

Sdlect Microsoft Power Point Viewer 97 to start the Viewer program.

Click the Look in: pop-up menu and select your CD-ROM drive.

Choose a presentation (e.g., PAL1 Chapter 01).

When you start a presentation, you will see an opening dide. Click the Forward
button to proceed to the next dide.

From the Contents dide click the gppropriate hyperlink to view the lesson dides.
Click the Help button for detailed instructions.

To end the presentation, click the Exit button or press the Esc (escape) key.

SYSTEM REQUIREMENTS

Verify that your computer system mests the following hardware and software
requirements listed below.

IBM PC (or 100%-compatible) computer

Pentium 90 MHz microprocessor (or higher)

4x CD-ROM (or faster)

Windows 95 (or later)

16 MB memory (32 or more MB recommended)

color monitor with high color (800 x 600 or higher) resolution
video card (1 MB memory or better)

hard drive (20 MB free)

mouse

28.8 modem (or faster) (optiona, but needed to utilize some features)
printer (optiona, but recommended)
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NAVIGATING THE SOFTWARE

Using the I nteractive Chalkboard software is easy. Once you select a presentation, just
use a mouse or another compatible pointing device to step through a dide show. Asyou
view adide show, you can use the following buttonskeys to navigate a presentation:

\!) Use the Forward button to move forward one dide at atime through the
software.

3) Click on the Back button to move back to the previous dide.
@ Click on the Home button to display the Contents dide.

To go to the beginning of alesson, click on the Section Start button.
Depending on where you are working in a presentation, click on this button to
return to the dide from which you accessed a particular option.

EXIT
\_) Click on the Exit button or press the Esc (escape) key to end adide show.

3) Click the Help button to access the help fegture,

Press the Space Bar to display the next item on adide. If thelast item is dready
displayed, the program will display the next dide.

Use the Back space key to move to aprevious item on adide. If the no items appear on a
dide, the program will go to the previous dide.

The presentations dso include hyperlinks. A hyperlink to another dide or to a different
part of a presentation appears as blue, underlined text. When you click on ahyperlink,
the program takes you immediately to the location associated with the link. If you
accidentaly sdect ahyperlink, you can click the appropriate navigation button to return
to where you were.
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USING THE HELP SYSTEM

An extensve Help system isincorporated into | nteractive Chalkboard. Whenever you
need help, just click the Help button to display detailed ingtructions.

If the appropriate topic does not appear, click on the Contents button to see the table of
contents for the Help system. Or, click on the Sear ch button to find a particular topic.

CUSTOMIZING A PRESENTATION

IMPORTANT: If you are not thoroughly familiar with PowerPoint, practice creating
your own presentations. Y ou could aso work through atutorid to learn how to use the
powerful festures avallable in this program.

To customize a presentation, follow these steps:

1. Ingal PowerPoint 97 (or alater verson) on your computer if it is not aready
ingtaled.

2.  Before you make any changes to a PowerPoint presentation, you should create a
folder on your hard drive.

3. Since you cannot make changes to the presentations on the CD-ROM, copy the
presentation(s) to your hard drive. Copy them to the folder you have created. If you
have enough hard disk space, you can copy dl of the presentations to your hard
drive. Approximately 650 MB disk drive space is needed. Each presentation
includesdl of theart and linksin itsown file,

4.  Sinceyou copied the filesfrom a CD-ROM, they are set to read-only. If you change
adide show, you must save it under adifferent name; you can aso use Microsoft
Windows Explorer to change the properties for these files. Right-click on afile
name that you copied to your hard drive, choose Properties, and then turn off the
read-only attribute,

5. Customize the presentation to meet your classroom needs. Refer to the suggestions
and tips listed below before you make any changes to a presentation.

- If you have deleted any art element (e.g., abutton or apicture) from a
presentation, you will need to copy the dement from another presentation or
dide within the current presentation if you want to insert the eement back
into adide show. Separate art eements are not provided as part of
I nteractive Chalkboard.

All presentations use the custom show feature for dl features accessed
through buttons on bottom of the dides. Y ou should fully understand how
custom shows function before making any modifications to these dides. If,
for example, you add a dide to a trangparency, you must aso update the
corresponding custom show ligt so that PowerPoint will know how to
display the new dide.
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CUSTOMIZING A PRESENTATION (continued)

Changes to the Lesson dides can easily be made since these dides are not
part of acustom show. Y ou can add dides, ddete dides, and update dides
as needed.

Hyperlinks and action settings are used to control the action for many of the
buttons found in a presentation. Making changes to a hyperlink action
setting isreatively sraightforward. However, a specid launcher program
(fscstart.exe) controls how the Help and the Internet Connect buttons
operate. If you change any of these buttons or add new buttons, you need to
understand the syntax for the launcher program. To use the launcher
program, choose to assign an action setting to an object. Indicate that you
want to add a setting that runs a program. Enter the launcher program name
aong with the gppropriate switch to perform the desired action.

- To display the help informétion, ... fscstart /PAL /3 101

- To launch www.pre-alge.com, ... fscgtart /PAL /5/115

TROUBLESHOOTING TIPS

The presentation isdifficult to read when displayed on a screen.

The qudity of the images projected through PowerPoint depends on severd factors.
Make sure that you are displaying the image onto a reflective surface—not a blackboard
or other amilar surface. Using a better screen can greetly improve the display qudity.
Darken theroom if possible. Check the quality of your projector. This, too, greatly

impeacts the display qudity.

The navigation buttons do not seem to work properly.

Click the Exit button or press the Esc (escape) to exit the dide show. If you are using the
Viewer, choose the presentation again to sart the dide show at the beginning. If you are
using PowerPoint 97, press the Home key to scrall to the first dide in the presentation
and then choose Slide Show in the View menu to start the presentation at the beginning.

Clicking theright mouse button does not move backward.

Using the Viewer, click on the Options button that appears when you first start the
Viewer. Change the settings S0 that a right-click does not display the pop-up menu. Using
PowerPoint 97, click on the T ools menu, choose Options, and click on the View tab.
Turn off the setting so that the pop-up menu does not gppear on right-clicks.

Colorson the didesdo not seem correct.

The I nteractive Chalkboard software requires that you set your monitor to high-color
(16-hit) or better. If your monitor is set for 256-colors, the qudity of the images asthey
gppear on your screen may not be very good. (See the next tip for ingtructions on how to
check or change your color settings.)
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TROUBLESHOOTING TIPS (continued)

How do you set the screen resolution and color s?

Depending on your computer system and projector, you may need to set your monitor to
800 x 600 resolution. Using these ingtructions, you can aso change the color setting.
Right-click on the Desktop. From the pop-up menu, choose Properties, and then click on
the Settings tab. Make the necessary changes on the Settings screen.

The highest color setting modeis 256-colors.

For best results, upgrade your video card and driver to support high-color (16-bit) mode
or better. If you are usng a SuperVGA monitor, you should not have to change your
monitor. The various levels of color settings are more afactor of the video card and how
much memory it hes.

While viewing a presentation, some portions of the screen are not updated.
Idedlly you want to display | nteractive Chalkboard a 800 x 600 or higher resolution.
Some video drivers may have difficulty displaying full-color didesin 800 x 600 (or
higher) resolution. An update to your video driver may be available from the equipment
vendor. If updating your video driver does not correct the problem, right-click on the
Desktop. From the pop-up menu, choose Properties and then click on the Settings tab.
Change the resolution to 640 x 480. Y ou may aso have to change your projector
equipment to display in the same mode.

Thetext isnot clear on the projected image, but the text isokay on the monitor.
The resolution for a projector needs to match the resolution for your monitor. If your
monitor is set to 800 x 600, for example, text may ook squeezed on a projected image.
Refer to your projector's manud for ingtructions on setting the display resolution.

When the program displays a new dide, the mouse pointer does not immediately
appear.

Thisisafunction of PowerPoint. After anew dide gppears, move the mouse afew times
to get the pointer to appear. PowerPoint won't show the mouse until you move it so that
the pointer does not interfere with your presentation.

L ong delays seem to occur randomly while viewing a presentation using Micr 0soft
Power Point 97 (or alater version).

If you are usng PowerPoint 97 (not the Viewer), you may want to turn off the
AutoRecovery/AutoSave feature. To do this, choose Options from the Tools menu,
select the Save tab, and turn off the appropriate option. Since the presentations are quite
large, saving the files may require afew moments. If you are viewing a presentation at

that time, the dide show will appear not to respond. Even though you are viewing adide,
Microsoft PowerPoint 97 will till autosave any open files according to the set

parameters.
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TROUBLESHOOTING TIPS (continued)

A ddlay may dso occur when you click onthe Connect button. Clicking on this button
launches your browser, dias your phone (if necessary), and connects to the textbook’s
Web ste. Depending on the speed of your computer, afew minutes may be required.

Power Point has difficulty displaying a presentation stored on a network drive or
CD-ROM network server.

I nteractive Chalkboard must be ingaled localy on each computer that will run the
presentations. There may be noticeable delays running from a network. These delays can
be caused by network speed, network traffic, or the server. See your network
adminigrator if you are having difficulties

Clicking the Connect button does not launch your Web browser.

Y ou must have Netscape 4.0 or Explorer 4.0 (or later versgons) instaled on your
computer. When you dlick on the Connect button, aminute or two may be needed for the
Web browser to launch and connect to the Internet. If you do not have enough memory or
you experience problems with the connection, the Web browser may not start properly.

Y ou can quit the I nteractive Chalkboard software and manualy launch your Web
browser. Then go to the Web site that is specified on the dide.

A memory overflow error appearswhen printing dides, or only a portion (e.g., half)
of adideprints.

If you try to print adide that includes large art dements, your printer may display a
memory overflow error or the printer may only print a portion of adide. First, make sure
that you are printing in the black and white mode. All of the presentations have been
optimized so that only the most important information prints. Background art should be
turned off. If you add your own dides, this may not be the case. Choose Black and
White from the View menu. Then right-click on an object and set its black and white
format. For example, you can choose not to show an object in black and white mode.

Another option to try isto set the Print What: fidd in the Print dialog box. Choose to
print handouts (2 or 3 handouts per page). This option may aso dleviate printing
problems.

If you want to print dideswith dl of the art ements, you may need to add more memory
to your printer. See the manud that accompanies your printer for more information.

The screen goes black when you attempt to view the show.
PowerPoint 2000 loads the entire presentation into memory when you begin to view the
show. This causes adelay of up to aminute or two when you start a presentation.
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TROUBLESHOOTING TIPS (continued)

A dide show does not work properly after making changesto a presentation.
The I nteractive Chalkboard dide shows contain many hyperlinks and action settings.
Make sure that you did not accidentally delete or change any of these. To check for
missing dides, use the Side Sorter view. In this mode, you can view severd dides at one
time.

All of the presentations use the custom show feature for al festures accessed through
buttons on the bottom of the dides.

Y ou should fully understand how custom shows function before you make any changes

to these dides. If, for example, you add a dide to one of these parts, you must also update
the corresponding custom show list so that PowerPoint will know how to display the new
dide.

None of the troubleshooting tips solve the problem.
If you have not customized the presentations, cal the Glencoe/M cGraw-Hill technicd
support number listed below.

If you have difficulty customizing a presentation, you may want to access the Microsoft
Web gite at http:/Aww.micr osoft.com for assstance with your problem. At this Web
gte, you can search through an online support database. Another excellent source for help
is the Microsoft PowerPoint discussion group at micr osoft.public.power point.

Glencoe provides toll-free telephone ass stance for teachers who experience difficulty
while usng our software or templates. Before calling for assstance, please check the
falowing:

Is your computer working properly? On the same computer, try some other
software that you know is working.

Can you repest the problem?

Does the problem occur at the same point each time?

Review thelist of troubleshooting tips below to seeif your problem isidentified.

In order for the Support Center to help you as quickly as possible, have the following
information a hand when you cal for assstance:

exact title and 1SBN number of the software from the disk labd or package
brand, modd, and configuration of the computer and printer you are using
verson of the operating system ingtalled on your computer

The Glencoe Support Center toll-free number is 1-800-437-3715. The Support Center is
available from 8:00 am. to 6:00 p.m. Eastern Time. Y ou can also contact the Support
Center on the Internet at the following e-mall address: epgtech@mcgraw-hill.com
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